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Overview 

 

Department of Energy, Labor & Economic Growth 

Michigan Workers' Compensation Agency 

Workers’ Comp Calculation System 

This system is used to calculate/validate workers’ compensation payments. It enables the user to determine the correct weekly 
rate of compensation which is payable on general disability claims as well as provide the 80% rate used to determine partial 
payments. It also calculates the amount due for any given period(s), including interest, if owed. It is updated yearly as new rate 
tables are published.  
  
This system is used to perform the following functions: 
  
1. Weekly Comp Rate screen - Calculates the weekly rate of compensation which is due on general disability claims as well 

as provides the 80% rate used to determine partial payments. This screen also includes a space for discontinued fringes. 
The 80% rate will always be calculated based on the total of the average weekly wage and the discontinued fringes, but the 
general disability rate will be limited to 2/3 of the state average weekly wage, when applicable. 

2. Disability Period screen - Calculates the number of weeks and days for any given period and indicates the total 
compensation due for that period. It also calculates an end date based on a beginning date and the number of weeks 
desired. 

3. Accrued Payment & Interest screen – Calculates the amount of accrued benefits and interest due for one or more given 
periods 

4. Partial Benefits screen. - After entering in the pre and post-injury wage information, this screen will calculate the partial 
benefits that are due for each weekly period entered. The file can then be saved so that future periods can be calculated. 
Reports can also be printed so they can be attached to the Form 701 whenever partial benefits are terminated or at the end 
of each year. 

5. Coordination of Benefits screen - This screen is used when an individual is receiving a benefit that can be coordinated 
under Section 354, including pension, wage continuation, disability insurance, self-insurance, or old-age Social Security 
benefits. A report can also be printed. 

6. Third Party Recovery Offsets screen - This screen is used when an individual has received a third party recovery. The 
amount of the offset is calculated using the formula set forth in the Franges decision. A worksheet can also be printed. 



5 

Installation Instructions 

Hardware and Software Requirements 

 PC with a 486DX/66 MHz or higher processor; Pentium or higher processor recommended. 
 Microsoft Windows 95 or later operating system or Microsoft Windows NT operating system version 4.0 with Service 

Pack 6 or later. 
 Minimum of 16 MB of RAM for Windows 95 or later (32 MB recommended). 
 Minimum of 24 MB of RAM for Windows NT 4.0 (32 MB recommended). 
 Minimum of 15 MB of Hard Disk space. 
 VGA or higher-resolution monitor; Super VGA recommended. 
 Microsoft Mouse or compatible pointing device. 
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Internet Installation 

Overview 
This topic describes how to install the Workers Comp Calculation System on a personal computer from the Internet. Before 
installing, please check the Hardware and Software Requirements topic to ensure that the PC this software will be installed on 
meets the requirements. The instructions below presume that you are already connected to the Internet and are in your Web 
Browser. 
  

1. You must uninstall any previous versions of the Workers' Comp Calc System that are installed on your computer in 
order for the new version to work properly. To do this, do the following: 
 Click on the Start button 
 Go to Settings, Control Panel, Add/Remove Programs. 
 Scroll through to find the Workers' Comp Calc System and click Remove. 

2. Once the uninstallation program has run, you can start the installation of the new version. 
3. Go to the Workers Comp Web Download Site at:  http://www.michigan.gov/wca. 
4. Download the Setup.exe file to your computer. Make note of where you downloaded this file. 
5. After the download has completed successfully, start up Windows Explorer. 
6. Using Windows Explorer, locate the Setup.exe file in the location that it was downloaded. 
7. An "InstallShield Wizard" window will be displayed for you to install this program. 
8. Select the Next button to continue with the installation. 
9. A "Readme Information" window will be displayed, informing you of new updates and important information. 
10. Select the Next button to continue. 
11. A "Customer Information" window will be displayed, asking you for your user name and organization, as well as how you 

want to install the program. 
12. Select the Next button to continue. 
13. An "InstallShield Wizard Complete" window will be displayed telling you setup completed successfully and offering to 

launch the program. If you do not wish to launch the program at this time, uncheck the check box.  
14. Select the Finish button to complete this installation process. 
15. The "Workers Comp Calculation System" should now be successfully installed. 
16. To start up the "Workers Comp Calculation System", do one of the following: 

 Leave the Launch the Program check box selected after installation. 
 Double click the Workers Comp Calc System Icon that Setup should have placed on your desktop. 
 Select the Windows Start button, select Programs, Workers Comp Calc, and select the Workers Comp Calc 

System Icon. 
20. If this is the first time the program has been run and you do not have existing partial data files in C:\PARTIAL_DATA, a 

screen will prompt you to set up the PARTIAL_DATA folder. If you have partial data files located in a location other than 
C:\PARTIAL_DATA, use the Browse button next to Current Location and select the location of the existing files. You 
can then click Save & Exit or you can move the files to a new location. If you do not have any existing partial data files, 
use the Browse button next to New Location, select a location to create the new files, click the Create files in new 
location button, click Yes on the next screen, then click Save & Exit. This screen will not appear again as long as the 
PARTIAL_DATA folder is present. 
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CD ROM Installation 

Overview 
This topic describes how to install the Workers Comp Calculation System on a personal computer. Before installing, please 
check the Hardware and Software Requirements topic to ensure that the PC this software will be installed on meets the minimum 
requirements. If the Workers Comp Calculation System has been previously installed, the old system should be uninstalled first. 
See the Uninstall Information topic for more information. 
  

1. Insert the Workers Comp Calculation System CD in your CD ROM Drive. 
2. If the Autorun does not automatically bring up the setup program, open up Windows Explorer, select your CD ROM 

Drive (Ex: D:) . 
3. Locate and double click the Setup.exe file (Ex: D:\Setup.exe). 
4. An "InstallShield Wizard" window will be displayed for you to install this program. 
5. Select the Next button to continue with the installation. 
6. A "Readme Information" window will be displayed, informing you of new updates and important information. 
7. Select the Next button to continue. 
8. A "Customer Information" window will be displayed, asking you for your user name and organization, as well as how you 

want to install the program. 
9. Select the Next button to continue. 
10. A "InstallShield Wizard Complete" window will be displayed telling you setup completed successfully and offering to 

launch the program. If you do not wish to launch the program at this time, uncheck the check box.  
11. Select the Finish button to complete this installation process. 
12. The "Workers Comp Calculation System" should now be successfully installed. 
13. To start up the "Workers Comp Calculation System", do one of the following: 

 Leave the Launch the Program check box selected after installation. 
 Double click the Workers Comp Calc System Icon that Setup should have placed on your desktop. 
 Select the Windows Start button, select Programs, Workers Comp Calc, and select the Workers Comp Calc 

System Icon. 
14. If this is the first time the program has been run and you do not have existing partial data files in C:\PARTIAL_DATA, a 

screen will prompt you to set up the PARTIAL_DATA folder. If you have partial data files located in a location other than 
C:\PARTIAL_DATA, use the Browse button next to Current Location and select the location of the existing files. You 
can then click Save & Exit or you can move the files to a new location. If you do not have any existing partial data files, 
use the Browse button next to New Location, select a location to create the new files, click the Create files in new 
location button, click Yes on the next screen, then click Save & Exit. This screen will not appear again as long as the 
PARTIAL_DATA folder is present. 
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Uninstall Information 

This topic includes instructions on uninstalling the Workers Comp Calculation System. This may be necessary if you are 
experiencing problems with the current version. 
  
If you are using the Workers Comp Calculation System Version 1.1.3 or higher, use these instructions to uninstall. 

1. Select the Windows Start button, Settings, Control Panel, Add/Remove Programs. 
2. From the "Add/Remove Program Properties" window, select the "Workers Comp Calculation System" from the list. 
3. Select the Add/Remove button. 
4. A "Confirm File Deletion" window will be displayed asking you if you really want to uninstall this product. 
5. If you selected Yes, UnInstallShield will remove all of the files from your computer. 

 Note: You may get a few windows informing you that you are removing files that are not used by other applications. Answer 
these questions carefully as removing some of the files could cause other programs not to work properly. 

6. Select the OK button to close the "Remove Programs From Your Computer" window. 
7. Select OK to close the Add/Remove Program Properties window. 

If you are using the Workers Comp Calculation System Version 1.1.2 or below, use these instructions to uninstall. 
1. Select the Windows Start button, Settings, Control Panel, Add/Remove Programs. 
2. From the "Add/Remove Program Properties" window, select the "Workers Comp Calculation System" from the list. 
3. Select the Add/Remove button. 
4. A "Windows Installer" window will be displayed briefly. 

 A "Welcome to the Workers Comp Calculation System Setup Wizard" window will be displayed.  
5. To uninstall this system, select the Remove Workers Comp Calculation System option. 
6. Select the Finish button to start the uninstall process. 

 Setup will remove all components of this system. 
 When finished, an "Installation Complete" window will be displayed.  

7. Select the Close button. 
8. Select OK to close the Add/Remove Program Properties window. 
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Workers Comp Calculation System 

Weekly Comp Rate Screen 

 
Purpose 
This screen is used to calculate/validate workers’ compensation payments. It enables the user to determine the correct weekly 
rate of compensation which is payable on general disability claims as well as provide the 80% rate used to determine partial 
payments. If discontinued fringes are entered, the calculation will limit the rate to 2/3 of the state average weekly wage, when 
applicable. 
How to use this screen 

1. Enter a valid four digit Year of Injury in the "Year of Injury" field. 
 Valid Years are 1966 thru 1981 and 1984 thru the present year. 
 Note: If you are not able to process the current year, make sure you are using the latest version. 

2. Enter the Gross Weekly Wage in the "Gross Weekly Wage" field. 
3. Enter the Discontinued Fringes, if any, in the "Discontinued Fringes" field. 
4. Enter the Number of Dependents in the "Nbr of Dependents" field. 
5. Enter the Tax Class Code in the "Tax Class" field. 

 This field is not required for years of injury from 1966 thru 1981. 
6. Select the Calc Weekly Comp button to calculate both the 80% Rate and the General Disability Rate. 
7. To clear all of the fields on this screen to their default values, select the Reset button. 
8. To Print a report with all of the calculated values on this screen, select the Print button. 
9. To carry the Comp Rate forward to the Disability Period screen, select the Carry Comp Rate forward to Disability 

Period checkbox. 
  
To use Keyboard Shortcuts on this screen, select the CTRL Key plus the underlined letter of the function you wish to perform. 
  

For Example:  
 To Calculate the Weekly Comp, select the CTRL+W key combination. 
 To Reset the screen fields to their original values, select the CTRL+R key combination. 
 To print the report, select the CTRL+P key combination. 
 To Exit out of this screen, select the CTRL+E key combination. 
 To go to the next page (or Tab), select the Page Down key. 
 To go to the previous page (or Tab), select the Page Up key. 

To display On-Line Help for this screen, either press your F1 key, or select the  button. 
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Disability Period Screen 

 
Purpose 
This screen is used for two different purposes. One is to calculate the Total Comp by Date Range, as in the picture above. The 
other is to Calculate the Total Number of Weeks from a specific date. See # 2 below. 
  
How to use this screen 

1. To Calculate the Total Comp using a Date Range, do the following: 
 Select the Calculate by Date Range option. 
 Enter a date in the "Beginning Date" field. 
 Enter a date in the "Ending Date" field. 
 Enter the weekly comp rate in the "Weekly Comp Rate" field. 
 Enter the days worked per week in the "Days Worked Per Week" field. 
 Note: All DOI’s on and after 5-11-1999 must be calculated on a 7 day work week. 
 5 Day Work Week Definition: This system expects that a 5 Day Work Week is Monday thru Friday. If a 5 Day Work Week 

is selected, Saturday and Sunday will not be included in the calculation. In other words, if you have a Beginning Date of 
01/01/2000 (Saturday) and an Ending Date of 01/02/2000 (Sunday), the Total Comp Payment for the Period will be 0.00. 

 Select the Calculate Total Comp button to calculate the Total Weeks, Remaining Work Days, and the Total Comp for the 
given date range. 

 To clear all of the fields on this screen to their default values, select the Reset button. 
 To Print a report with all of the values on this screen, select the Print button. 
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2. To Calculate the Total Number of Weeks, do the following: 

 Select the "Calculate Nbr of Weeks" option. 
 Enter the number of weeks in the "Nbr of Weeks" field. 
 Enter a date in the "Beginning Date" field. 
 When you leave the Beginning Date field, the "Ending Date" will automatically be calculated (displayed in red). 

  
Most Keyboard Shortcuts on this screen use a CTRL Key plus the underlined letter of the function you wish to perform. 

 For Example:  
 To Calculate the Total Comp, select the CTRL+T key combination. 
 To Reset the screen fields to their original values, select the CTRL+R key combination. 
 To Print the report, select the CTRL+P key combination. 
 To Exit out of this screen, select the CTRL+E key combination. 
 Right Mouse options are also available as described below: 
 To fill any Date Field using a Calendar screen, do the following: 
 Right click the mouse button when in a Date Field. 
 A Calendar screen will appear. 
 Using your mouse, select a date using the Calendar. 
 Click the Select button. 
 The date you selected will be pre-filled in your date field. 
 See the Calendar Screen Topic for more information. 
 To go to the next page (or tab), select the Page Down key. 
 To go to the previous page (or tab), select the Page Up key. 

To display On-Line Help for this screen, either press your F1 key, or select the  button. 
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Accrued Payment and Interest Screen 

 
Purpose 
This screen is used to calculate Accrued Payments & Interest for one or more payment periods. 
  
How to use this screen 

1. Enter the starting date of the first payment period in the Beginning Date field. 
2. Enter the ending date of the first payment period in the Ending Date field. 
3. Enter the date that the payment will be made in the Date Paid field. 
4. Enter the Comp Rate for the first payment period in the Weekly Comp Rate field. 
5. Enter the days worked per week in the Days Worked Per Week field. 

 Note: All DOI’s on and after 5-11-1999 must be calculated on a 7 day work week. 
6. Calculate the accrued information by selecting the Calculate Accrued button. 
7. The information for the first week will be calculated in red to the right of the data entry fields and also added to the grid 

at the bottom of the screen. In addition, the "Beginning Date" will be automatically calculated for you for the next period 
and the cursor will be positioned in the "Ending Date" field. 

 Note: The "Beginning Date" can still be changed, if desired. 
8. Continue entering all remaining payment periods by following the steps above until completed. 
9. To make changes to records that were entered incorrectly, do the following: 

 Select the record that is incorrect by clicking on it in the Grid at the bottom of the screen. 
 Either select the Edit button, or Right Click the mouse button to display a menu and select the Edit the Current record 

option. 
 Change the information for the current record. 
 Select the Calculate Accrued button to add it back to the list. 

10. To Delete a record, do the following: 
 Select the record that needs to be deleted by clicking on it in the grid at the bottom of the screen. 
 Either select the Delete button, or Right Click the mouse button to display a menu and select the Delete the Current 

Record option. 
11. To clear all of the fields on this screen to their default values, select the Reset button. 
12. To Print a report with all of the values on this screen, select the Print button. 

  
Most Keyboard Shortcuts on this screen use a CTRL Key plus the underlined letter of the function you wish to perform. 

 For Example:  
 To Calculate the Accrued information, select the CTRL+A key combination. 
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 To Reset the screen fields to their original values, select the CTRL+R key combination. 
 To print the report, select the CTRL+P key combination. 
 To Exit out of this screen, select the CTRL+E key combination. 
 Right Mouse options are also available as described below: 
 To fill a Date Field using a Calendar screen for any Date Field, do the following: 
 Right click the mouse button when in a Date Field. 
 A Calendar screen will appear. 
 Using your mouse, select a date using the Calendar. 
 Click the Select button. 
 The date you selected will be pre-filled in your date field. 
 To Edit the records in the Grid at the bottom of the screen, do the following: 
 Right click the mouse button when in a row of the grid that you wish to modify. 
 A menu will appear as displayed below. 

 
 

 Select the desired menu option. 
 To go to the next page (or tab), select the Page Down key. 

 To go to the previous page (or tab), select the Page Up key. 

To display On-Line Help for this screen, either press your F1 key, or select the  button. 
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Third Party Recovery Offsets 

 
Purpose 
This screen is used to calculate Third Party Recovery Offsets based on the Franges decision. The calculation WorkSheet can be 
printed. 
How to use this screen 

1. Enter the Gross Recovery amount in the "Gross Recovery" field. 
2. Enter the Preparation Costs in the "Preparation Costs" field. 
3. Enter the Reasonable Attorney Fee amount in the "Reasonable Attorney Fee" Field. 
4. Enter the Total Workers’ Comp Paid as of the Settlement Date in the "Total W/C Paid as of Settlement Date’ field. Zero 

can be entered if no benefits have been paid. 
5. In W/C Rate field, enter the Worker’s Comp Rate. 
6. Click the Calc Recovery Offsets button to complete the calculations. 
7. All amounts are shown on the screen. There is a print option to print the Franges Worksheet. 
8. Reset will delete all entries.  

Most Keyboard Shortcuts on this screen use a CTRL Key plus the underlined letter of the function you wish to perform. 
 For Example:  
 To calculate the Third Party Recover Offset, select the CTRL+S key combination. 
 To Reset the screen fields to their original values, select the CTRL+R key combination. 
 To print the report, select the CTRL+P key combination. 
 To Exit out of this screen, select the CTRL+E key combination. 
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Coordination of Benefits 

 
Purpose 
This screen is used to calculate the Coordination of Benefits for Pension, Wage Continuation, Disability Insurance, and Self-
Insurance Plans. It enables the user to determine the Amount to be Coordinated (either by including or excluding FICA and State 
Income Tax). This screen also has the ability to calculate coordination of Old-Age Social Security Benefits. In order to be 
consistent with recent case law regarding the calculation of partial benefits, the program calculates coordination of benefits 
based upon the year benefits are received rather than the year of injury. 
  
How to use this screen 
1. Enter a valid four digit Year that the benefit was received in the Year Benefit Received field. 
2. Enter the Number of Dependents in the Nbr of Dependents field. 
3. Enter the Tax Class Code in the Tax Class field. 
4. Enter the Weekly Amount of Coordinatable benefit in the Weekly Benefit Amt. field. 
5. If the benefit plan is not subject to FICA, click on the ‘NO’ checkbox and FICA will be added back in (since it was removed 

during the 80% after tax calculation in line 2). 
6. If the benefit plan is not subject to state income tax, click on the ‘NO’ checkbox and state income tax will be added back in 

(since it was removed during the 80% after tax calculation in line 2). 
7. Enter the Percentage of Employer Contribution in the Percent of Employer Contribution field. 
8. Select the Plan Type by clicking on the dropdown box for Plan Type. 
9. To calculate the Coordination of Benefits, Click on the Calc Benefits button. 

  
To calculate the Old-Age Social Security Benefits portion of the screen: 

1) Enter the Monthly Old Age Benefit Amount in the Old Age Benefit Amount field. 
2) Click on the Calc Wkly button to calculate the Weekly Old Age Benefit Amount and the Amount to be  
Coordinated.  

  
To use Keyboard Shortcuts on this screen, select the CTRL Key plus the underlined letter of the function you wish to perform. 

For Example:  
 To Calculate Coordination of Benefits, select the CTRL+B key combination. 
 To Reset the screen fields to their original values, select the CTRL+R key combination. 
 To Calculate Old-Age Social Security Benefits, select the CTRL+K key combination. 
 To print the report, select the CTRL+P key combination. 
 To Exit out of this screen, select the CTRL+E key combination. 
 To go to the next page (or Tab), select the Page Down key. 



16 

 To go to the previous page (or Tab), select the Page Up key. 

To display On-Line Help for this screen, either press your F1 key, or select the  button. 
Reset will delete all entries on the screen. 

  
Special Features 

This screen has an option to print a report, which displays all the above calculations in an easy-to-read format. Select the 
Print button to print the report.  
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Partial Benefits 

 
Purpose 
This screen is used to determine the correct partial rate of compensation. The records will be saved under a chosen file name 
until the user chooses to delete them.  
  
How to use this screen 
The first step is to create a file name. 
1. Click on the Add/Edit File button on the screen in the upper left corner. This will take you to the Partial Records screen.  
  
Partial Records Screen 

 
  
To Create a New File 

1. Click on the New button. 
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2. Type in a file name of your choice in the File Name field.  
3. Click on the Save button. 
4. To work on the file that was just created, click on the File Name in the box and click on the Exit button at the bottom of 

the screen. 
To Rename an Existing File 

1. Click on the File Name that you would like to rename from the list in the box. 
2. Click on the Edit button. 
3. Edit the new file name in the File Name field. 
4. Click on the Save button to save your changes. 

To Delete Selected Files 
1. Click on the File Names that you would like to delete. Hold your Ctrl key down when selecting more than one file. 
2. Click on the Delete Selected button to delete the selected files. 

To Delete All Files 
1.  Click on the Delete All button to delete all of the files at once. 

Click the Exit button to return to the previous screen (Partial Benefits Screen) 
  
Entering Partial Benefits Calculations on the Partial Benefits Screen 

1. Select a File Name by clicking on the File Name dropdown box. 
2. Enter the Injury Year in the Inj. Year field. 
3. Enter the Gross Weekly Wage in the AWW Before Inj. field. 
4. Enter the Discontinued Fringes amount, if any, in the Disc. Fringes field. 
5. Enter the number of dependents in the Dependents field. 
6. Enter the Tax Class in the Tax Class field. 
7. Click on the Calc button to the right of the file name to calculate the 80% Before Rate for this file. 
8. To calculate the Partial Rates, enter the Beginning Date in the Beg Date field. 
9. The Ending Date will be pre-filled for you based on a seven day week. 
10. The Year Paid field will be pre-filled with the end date year, although you may enter a different Year, if necessary. 
11. The 80% Before amount will be pre-filled for you. 
12. Enter the Wage After amount in the Wage After field. 
13. Click the Calc button on the middle right half of the screen to calculate the 80% After amount and the Partial Rate. 
14. Continue entering the Wage After amount in the Wage After field until you have completed all entries. The system will 

automatically fill the new begin date, but this can be changed if necessary. 
15. All records are automatically saved. 
16. The Print Options button may be selected to print all records for a file or only those that were paid in a specific year. 

This report can then be attached to the Form 701 at the end of the year or when partial benefits are terminated. 
Most Keyboard Shortcuts on this screen use a CTRL Key plus the underlined letter of the function you wish to perform. 

 For Example:  
 To calculate the 80% Rate, select the CTRL+L key combination. 
 To calculate the Partial Benefits Rate, select the CTRL+C key combination. 
 To Reset the screen fields to their original values, select the CTRL+R key combination. 
 To print the report, select the CTRL+P key combination. 
 To Exit out of this screen, select the CTRL+E key combination. 
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Additional Information 

About Screen 

 
Purpose 
This screen is used to verify Version and other related information. Every time changes are made to this system, the Version 
Number will be incremented, so this number can be useful to verify that the users are using the current version. 
  
How to use this screen 

 This screen has information that is display only. No processes are available in this screen. 
 To verify that you have the latest version, check the Product Version, File Date and File Time. Check our web site to see 

what the latest available version is.  
 To get the latest version of this software, please ensure that you are connected to the Internet, then go to our web site, 

at: http://www.michigan.gov/wca. 
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Data Location Screen 

 
 
Purpose 
This screen is used to set the location where the Partial Data tables will be created and saved. 
  
 
How to use this screen 

1. The first time you come into this screen, if your files exist in C:\PROGRAM FILES\WCCALC\PARTIAL_DATA, the 
current location will default to that path. If you have files located in another location, use the Browse button to locate 
those files on your hard drive. You can leave the files in their current location or move them to another location on the 
drive the program is installed. If you do not have any current partial files, you will need to create them.  
 To move existing partial files: 

1. Make sure the label stating that Partial files exist in above location is highlighted below the Current 
Location.  

2. Use the Browse button in the New Location to select the location where you want to move your files. The 
location must be on the same drive that the program was installed. The default location for the New Location 
is C:\PROGRAM FILES\WCCALC\PARTIAL_DATA. 

3. Once you have selected a New Location, the Move files to new location and Create files in new location 
buttons will activate. Select Move files to new location.  

4. A message will appear asking you if you want to continue. If everything is correct, click Yes. Once you have 
clicked Yes, you should see a screen similar to the one below: 

 

    
 
5. Click Save & Exit to leave this screen. 
 

 To create new partial data files: 
1. Your screen will look similar to this when you first open the WCCalc Program: 
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2. Use the Browse button in the New Location to select the location where you want to create your files. The 

location must be on the same drive that the program was installed. The default location for the New Location 
is C:\PROGRAM FILES\WCCALC\PARTIAL_DATA. 

3. Once you have selected a New Location, the Move files to new location and Create files in new location 
buttons will activate. Select Create files in new location.  

4. A message will appear asking you if you want to continue. If everything is correct, click Yes. Once you have 
clicked Yes, you should see a screen similar to the one below: 

    
5. Click Save & Exit to leave this screen.  
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Keyboard Shortcuts 

This topic displays all of the available Shortcuts for this system. They are categorized by the area in which they are available. 
 
Menu Shortcuts: 

 Alt + Y - Selects the "System" menu option. 
 Ctrl + B - Selects the "Rebuild Indexes" menu option. 
 Alt + F4 - Selects the "Exit" menu option. 
 Alt + E - Selects the "Edit" menu option. 
 Ctrl + X - Does a "Cut" of the selected text. 
 Ctrl + C - Does a "Copy" of the selected text. 
 Ctrl + V - Does a "Paste" of the selected text. 
 Ctrl + N - Turns the Tool Tips On. 
 Ctrl + F - Turns the Tool Tips Off. 
 Alt + S - Selects the "Screens" menu option. 
 Ctrl + O - Selects the "Calculation Options" menu option. 
 Alt + W - Selects the "Window" menu option. 
 Ctrl + G - Selects the "Arrange All" menu option. 
 Alt + H - Selects the "Help" menu option. 
 F1  - Selects the "On-Line Help System" menu option. 
 Ctrl + L - Selects the "Calendar Screen" menu option. 
 Ctrl + Y - Selects the "About this System" menu option. 

 
Weekly Comp Rate Screen: 

 F1 - Selects the "Weekly Comp Rate Screen" Help topic. 
 Page Down - Goes to the "Disability Period" Screen. 
 Ctrl + W - Selects the "Calc Weekly Comp" button. 
 Ctrl + R - Selects the "Reset" button. 
 Ctrl + P - Selects the "Print" button. 
 Ctrl + E - Selects the "Exit" button. 

 
Disability Period Screen: 

 F1 - Selects the "Disability Period Screen" Help topic. 
 Page Down - Goes to the "Accrued Payment and Interest" Screen.  
 Page Up - Goes to the "Weekly Comp Rate" Screen. 
 Ctrl + T - Selects the "Calculate Total Comp" button. 
 Ctrl + R - Selects the "Reset" button. 
 Ctrl + P - Selects the "Print" button. 
 Ctrl + E - Selects the "Exit" button. 
 Right-click on Date field displays a Calendar Screen. 

 
Coordination of Benefits Screen: 

 F1  - Selects the "Coordination of Benefits Screen" Help topic 
 Page Up - Goes to the "Weekly Comp Rate" Screen. 
 Page Down - Goes to the "Third Party Recovery Offsets" Screen. 
 Ctrl + B - Selects the "Calc Benefits" button. 
 Ctrl + K - Selects the "Calc Wkly" button. 
 Ctrl + R - Selects the "Reset" button. 
 Ctrl + P - Selects the "Print" button. 
 Ctrl + E - Selects the "Exit" button. 
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Partial Benefits Screen: 
 F1 - Selects the "Partial Benefits Screen" Help topic. 
 Page Up - Goes to the "Accrued Payment & Interest" Screen. 
 Page Down - Goes to the "Third Party Recovery Offsets" Screen. 
 Ctrl + L - Selects the "Calc" button for the 80% rate. 
 Ctrl + C - Selects the "Calc" button for the Partial rate. 
 Ctrl + R - Selects the "Reset" button. 
 Ctrl + P - Selects the "Print" button. 
 Ctrl + E - Selects the "Exit" button. 

 
Third Party Recovery Offsets Screen: 

 F1 - Selects the "Third Party Recovery Offsets" Help topic. 
 Page Up - Goes to the "Partial Benefits" Screen. 
 Page Down - Goes to the "Coordination of Benefits" Screen. 
 Ctrl + S - Selects the "Calc Recovery Offsets" button. 
 Ctrl + R - Selects the "Reset" button. 
 Ctrl + P - Selects the "Print" button. 
 Ctrl + E - Selects the "Exit" button. 

 
Accrued Payment and Interest Screen: 

 F1 - Selects the "Accrued Payment and Interest Screen" Help topic. 
 Page Up - Goes to the "Disability Period" Screen. 
 Ctrl + A - Selects the "Partial Benefits" button. 
 Ctrl + R - Selects the "Reset" button. 
 Ctrl + P - Selects the "Print" button. 
 Ctrl + E - Selects the "Exit" button. 
 Right-click on Date field displays a Calendar Screen. 
 Right-click on Grid at bottom of screen displays the following menu: 
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Calendar Screen 

 
  
Purpose 
This screen is used to locate dates for date fields within this system. This screen can be accessed either from any date field 
within this system, or from the Help Menu. 
  
How to use this screen 

1. Access this screen from a Date field: 
 From any Date field in this system, Right Click the Mouse button over the desired field. 
 Select the date in this Calendar screen that you want entered in the field you started from. 
 Verify that the date in the "Output Date" field is correct, as that will be returned in the starting field. 
 Select the "Select" button. This screen will then close. 
 If you wish to return to the previous screen without selecting a date, select the "Cancel" button. 
 Note: The Input Date field will display the date that was in the field you came in from. If it is empty, that means that 

the field you came from was also empty. 
2. Access this screen from the Help Menu. 

 Select the Help Menu (Alt + H). 
 Select the "Calendar Screen" option. 
 You can view dates using the Month & Year Drop down lists. 
 When finished, either select the "Cancel" or "Select" button. 

  
Special Features 

 This screen can be used to verify dates that are either in the future or in the past. 
 You can search for any dates between the years 1900 and 2100. 
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Rebuild Indexes Option 

The Rebuild Indexes Option (located in the System Menu) allows the user to rebuild all table indexes for this system. A reason 
for doing this is that sometimes Table Indexes will get corrupt. This may happen if a user’s PC is not properly shut down. If this 
system is running when this happens, then the table indexes may need to be rebuilt. It will not cause any harm to run this 
process as often as necessary. If Rebuilding the Indexes does not repair the problems encountered, then reinstalling the product 
may be necessary. Select the Installation Topic that best suits your situation. 
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 Contact Information 

To contact the Workers’ Compensation Agency about this program, please feel free to use one of the following methods. 
  
Email Address:  wcinfo@michigan.gov  
Phone Nbr: (517) 322-1438 
Workers Comp Web Site: http://www.michigan.gov/wca 
 
Want to be informed of Updates? 
If you would like to be informed through e-mail of new updates to our program, e-mail us at the address listed above and let us 
know. We will notify you when a new version is available on our web page. In addition, we will explain enhancements and other 
information related to the latest version. 
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Calculation Problems 

On an exception basis, the calculation program may produce a rate that is one cent different from the published rate books. 
Regardless of the discrepancy, it is acceptable to use the rate generated by the calculation program. 
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Troubleshooting 

Below are the known issues with this system at this time. If you need to contact someone to help you, see the Contact 
Information help topic for more information.  
  
Known Issues: 

1. Rounding Errors. The 80% Rate calculation is sometimes off by a penny. See the Calculation Problems topic for more 
information. 

2. Missing Rate Years. Rates for Tax Years 1982 and 1983 are not calculated by this system as we are not able to 
duplicate the published rate books. 

3. Foxuser files on desktop. Occasionally, after installing the Workers Comp Calculation System, a Foxuser.dbf and a 
Foxuser.fpt file gets placed on the Windows desktop. This happens after executing one of the Shortcuts for this system 
for the first time. If these files are removed from the desktop, they return the next time the system is run. Version 1.1.3 of 
this system has fixed this problem. To get the latest version, follow the steps below. 
 Install the Workers Comp Calculation System using the CalcInst.exe file that was downloaded from the web. See 

the Internet Installation help topic for more information. 
4. Installation problems. A few users have reported having problems getting this system to install properly. After running 

the CalcInst.exe file, they get a message that some files are missing.   
5. This problem has been fixed in Version 1.1.3. 
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Versions 

Version Information 

This topic will help you find out what version of this system you currently have, plus help you to get the latest version. Below is a 
list of the Versions that have been released so far, and information about each version. The Version help topics will explain what 
was fixed in that particular version, the date it was released, and more. 
Version 1.1.1 
Version 1.1.2 
Version 1.1.3 
Version 1.1.4 
Version 2.1.1 
Version 3.1.1 
Version 4.0 
Version 5.0 
Version 6.0 
Version 6.1 
Version 7.0  
Version 7.1 
Version 8.0 
Version 8.1 
Version 9.0 
Version 10.0 
  
  
  

 To find out what Version you currently have, see the About screen help topic. 
 To find out how to get the latest version using the Internet, see the Internet Installations help topic. 
 To go to our Internet web site now, click here if you are already connected to the Internet. 
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Version 1.1.1 

Version Nbr: 1.1.1 
Changes Made By: OTR Staff 
Types of Changes: Initial Implementation. 
Date of Install: 11-19-1999. 
Comments: This is the initial release of this Visual Foxpro system. This system replaces a Dbase system that was not Year 
2000 Compliant, and had conflicts running in Windows 95 or higher operating environments. This version calculates years of 
injury from 1966 thru 1981 and 1984 thru 1999.  
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Version 1.1.2 

Version Nbr: 1.1.2 
Changes Made By: OTR Staff 
Types of Changes: Initial Implementation. 
Date of Install: 12-29-1999. 
Comments: This version was updated to include rates for the year 2000. 
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Version 1.1.3 

Version Nbr: 1.1.3. 
Changes Made By: OTR Staff 
Date of Install: 02-03-2000. 
Types of Changes: 

1. Rounding Errors: A rounding error was discovered in the Disability Period Screen in the "Total Comp Payment for the 
Period" field. The third decimal was being truncated instead of Rounded, so some calculations were off by a penny. This 
has now been fixed to round to two decimal places. 

2. Foxuser files on Desktop: On a few users PC’s, when they started up the Workers Comp Calculation System, two files 
would be placed on their desktop. The foxuser.dbf and foxuser.fpt files. If the files are removed, then the system started 
again, the files would reappear. This problem has also been fixed. 

3. Disability Period Begin and End Date problem: The Disability Period Screen would not let you enter a Beginning 
Date and Ending Date that was the same. An error would be displayed stating that the Beginning Date could not be after 
the Ending Date. This has been changed to now allow you to calculate comp for one day. 

4. Accrued Screen Sort Problem: The Grid in the Accrued Payment & Interest Screen was sorting the data in alpha order 
instead of Date order. What this did was sort the data in the Grid by Month/Day/Year instead of Year/Month/Day. This 
has been fixed in this version. 

5. Installation Problems: A few users reported having problems installing this system. One message reported was "Error 
1305 Unable to find temp file WCCompinstall.msi". It appears that this file does not get unzipped from the Calcinst.exe 
executable. To fix this and a few other known problems we switched to a different installation method. We are now using 
InstallShield to create our setup executable. In our testing, the Error 1305 problem has been resolved. 
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Version 1.1.4 

Version Nbr: 1.1.4. 
Changes Made By: OTR Staff 
Date of Install: 06-06-2000. 
Types of Changes:  

1. Date Range Error: The Disability Period Verification screen did not allow the users to enter a From & Thru date that 
was the same. This has been fixed. 

2. Printer Tray Problems: Some printers would prompt the user to put paper in the fold down trays, which were 
considered to be Tray 1, but were not the default tray. The default printer tray should now be used correctly. 

3. Printer Report Problems: On the Disability Period Verification report, some printers would print asterisks in the Total 
Comp Payment For The Period field. This has now been fixed. 
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Version 2.1.1 

Version Nbr: 2.1.1 
Changes Made By: OTR Staff 
Date of Install: 01-16-2001. 
Types of Changes: 

1. New 2001 Rate Tables: This version has been modified to include rates for the year 2001. 
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Version 3.1.1 

Version Nbr: 3.1.1 
Changes Made By: OTR Staff 
Date of Install: 1-17-02. 
Types of Changes: This version includes the following changes: 

  
The Weekly Comp Rate screen has been modified to include a space for discontinued fringes. The 80% rate will always be 
calculated based on the total of the average weekly wage and the discontinued fringes, but the general disability rate will be 
limited to 2/3 of the state average weekly wage, when applicable. 
  
This version also includes three new screens: 
  
1). Partial Benefits. After entering in the pre and post-injury wage information, this screen will calculate the partial benefits that 
are due for each weekly period entered. The file can then be saved so that future periods can be calculated. Reports can also be 
printed so they can be attached to the Form 701 whenever partial benefits are terminated or at the end of each year. 
  
2). Coordination of Benefits. This screen is used when an individual is receiving a benefit that can be coordinated under 
Section 354, including pension, wage continuation, disability insurance, self-insurance, or old-age Social Security benefits. A 
report can also be printed. 
  
3). Third Party Recovery Offsets. This screen is used when an individual has received a third party recovery. The amount of 
the offset is calculated using the formula set forth in the Franges decision. A worksheet can also be printed. 
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Version 4.0 

Version Nbr: 4.0 
Changes Made By: BTS Staff 
Date of Install: 01-15-2003. 
Types of Changes: 

1. 2003 Rate Tables - The program has been modified to include rates for the year 2003. 
2. Partial Benefits Screen - The "Wage Before" column in the table will now display the total of the AWW and fringes, if 

any. Also, the program will now allow zero dollars to be entered in the "Wage After" field for those claims that go back 
and forth from temporary partial to temporary total. 

3. Coordination of Benefits Screen - In order to be consistent with recent case law regarding the calculation of partial 
benefits, the program will now calculate coordination of benefits based upon the year benefits are received rather than 
the date of injury. 

4. Accrued Payment & Interest Screen - The Grand Total columns in the table were causing confusion because they 
were really cumulative totals. Therefore, they have been removed and replaced by a Grand Total line at the bottom of 
the table. 

5. Third Party Recovery Offsets Screen - The program will now allow for zero dollars to be entered in Line 4 (Total W.C. 
Paid as of Settlement Date) since third party settlements sometimes take placed before any indemnity benefits are paid. 
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Version 5.0 

Version Nbr: 5.0 
Changes Made By: DIT Staff 
Date of Install: 01-05-2004. 
Types of Changes: 

1. 2004 Rate Tables - The program has been modified to include rates for the year 2004. 
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Version 6.0 

Version Nbr: 6.0 
Changes Made By: DIT Staff 
Date of Release: 01-14-2005. 
Types of Changes: 

1. 2005 Rate Tables - The program has been modified to include rates for the year 2005. 
2. Partial Data Files - The program has been modified to allow for creation of partial data files in a location of your choice 

on the drive that the program is installed. 
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Version 6.1 

Version Nbr: 6.1 
Changes Made By: DIT Staff 
Date of Release: 01-20-2005. 
Types of Changes: 

1. Data Location Screen - Disabled the "Move files to new location" button when there was no current location of partial 
data files. Also changed the Current Location to be blank upon entry if there are no existing partial data files in the 
default location. 
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Version 7.0 

Version Nbr: 7.0 
Changes Made By: DIT Staff 
Date of Release: 12-20-2005. 
Types of Changes: 

1. 2006 Rate Tables - The program has been modified to include rates for the year 2006. 
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Version 7.1 

Version Nbr: 7.1 
Changes Made By: DIT Staff 
Date of Release: 1-9-2006. 
Types of Changes: 

1. Updated State Average Weekly Wage - Version 7.0 contained an error in the maximum weekly benefit amount as a 
result of an improper state average weekly wage.  The maximum rate has been corrected in this version. 

2. 2006 Rate Tables - The program has been modified to include rates for the year 2006. 
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Version 8.0 

Version Nbr: 8.0 
Changes Made By: DIT Staff 
Date of Release: 12-21-2006. 
Types of Changes: 

1. 2007 Rate Tables – The program has been modified to include rates for the year 2007. 
2. Calculations for Higher Average Weekly Wages - The program has also been modified to include 80% after-tax rates for 

high average weekly wages.  This information is needed when calculating temporary partial benefits. 
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Version 8.1 

Version Nbr: 8.1 
Changes Made By: DIT Staff 
Date of Release: 1-25-2007. 
Types of Changes: 
  

1. Fixed issue with Calc button on Coordination of Benefits Screen – There was a problem with the “Calc” button on 
the Coordination of Benefits screen where it would not always work when clicked on. This issue has now been resolved. 
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Version 9.0 

Version Nbr: 9.0 
Changes Made By: DIT Staff 
Date of Release: 1-3-2008. 
Types of Changes: 
  

1. 2008 Rate Tables - The program has been modified to include rates for the year 2008. 
2. Calculations Error - The program has also been modified to fix a recently discovered calculation error involving low 
average weekly wages and discontinued fringes in which the prior benefit standard of 2/3 average weekly wage applies. 
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Version 10.0 

Version Nbr: 10.0 
Changes Made By: DIT Staff 
Date of Release: 1-12-2009. 
Types of Changes: 
  

1. 2009 Rate Tables - The program has been modified to include rates for the year 2009. 
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